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Mapping Tourist centers of Pune city using geospatial technology

Objective: To identify the tourist places in Pune city and map them using different typologies.
Software: Google Earth, Quantum GIS
Level: Advanced
Time required: 2 Hour
Prerequisites and Geospatial Skills:
1. Quantum GIS should be installed on the computer and basic knowledge of interface

2. Google Earth should be installed and Basic knowledge about the its interface
3. Should have completed all the GIS and RS tutorials from the dst-iget portal.

Tutorial Credits:, Mr. Sanjay Jagtap, Mr. Ganesh Dhawale, Mr. Praveen Kamble, Mrs.
Kanchan Misal, Mr. Gorakh Waje

Edited: Ms. Prachi Dev, Mr. Lakshmikanth Kumar and Prof. Dr. Shamita Kumar

Reading:
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Introduction:

Pune is the seventh largest city in India and second largest city in Maharashtra after Mumbai.
Pune Municipal Corporation (PMC) jurisdiction extends up to an area of 243.84 sq. km. housing
2.54 million populace within 144 wards. Referred as ‘Detroit of India’, the city has experienced a
long standing urban tradition: first as an historical center of pre-colonial urbanism, then as an
important military center during British rule, after independence as a rapidly growing
contemporary industrial center, and today identified as a growing metropolis. Pune, also known
as an ‘Oxford of India’, houses six Universities with about 600 functional higher education
centers catering to an estimated 5 lakh student population. Additionally, Pune is popularly
nicknamed as ‘Queen of Deccan’, ‘Pensioners Paradise’, ‘Cultural Capital of Maharashtra’,
‘Cyber City’ etc. owing to its location, pleasant climate, historical importance, vibrant culture
and upcoming IT-BT centers.

Location: Situated on leeward site of Deccan Plateau (Sanhyadri Hills/Western Ghats) between
189 32' North latitude and 72 ¢ 51’ East longitudes, Pune is well connected by road, rail and air
network with almost all the important cities within Maharashtra and India. The city is located at
the confluence of Mula and Mutha rivers (plains of Bhima and Nira River basin) at a height of
560 m above Mean Sea Level (MSL) and characterized by vast stretches of undulating plains
inter spread by low and medium ranges of hills.

In this tutorial we will see how we can demarcate these highly important places in the city of
Pune using geospatial technology. We will first list down the tourist places in Pune, then divide
them in proper typologies (e.g. Historical, Institutional) and then create meaningful maps out of
this dataset.

l. Listing of tourist’s places in Pune city.
1. We can take help of different tourism website available online to list down the places in

Pune city like Maharashtra tourism, Trip advisor etc.
2. The final list of tourist places listed for this exercise are as follows:

Pashan Lake Bharati Vidyapeeth Chatushrungi Temple

Dadusheth Ganapati | Savitribai Phule Pune University | Chhatrapati Sambhaji Park

Shaniwar Wada Furgusson college Janglimaharaj Temple

Saras Baug MIT college Pataleshwar Caves

Lal Mahal Sinhagad Institute Wadgaon Bund Garden

Peshwe Park TMV Pune Tribal Research Center
Kelkar Museum Parvati Hill St. Merys Church

Vishram Baug Wada | Shinde Chhatri Race Course

Empress Garden Rajiv Gandhi Zoo Park Ohel David Church

Agakhan Palace Balgandharv Rangmandir Yerawada Prison

Raj Bhawan Mahatma Phule Wada Kasba Ganpati

SNDT University Deccan College Osho International

Katraj Jain Temple PMC Building National War Memorial

Hadapsar Airport Agriculture College Deccan Gymkhana Ground

SP College St. Teresa Church
9 : Dr. Babasaheb Ambedkar
Dr. Ambedkar Mula-Mutha Bird sanctuary "
Sanskritik Bhavan
College

tzEt
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Now we have already listed down the tourist places, now we will move on to the next step of
dividing these tourist places in different categories based on its importance. You can add few

more if interested.

il. Identifying different typologies and dividing the list in these typologies.

If we see the list above, we can broadly classify them in four major groups.
a. Historical --- Places of historical importance

b. Institutional -- Old Educational buildings

c. Religious - Religion places
d. Other - include Zoo, Museums, Gardens etc.

Now we will divide the places above in the categories that we have finalized

Historical

Institutional

Religious

Others

Shaniwar Wada

Raj Bhawan

Dadusheth Ganapati

Pashan Lake

Lal Mahal

SNDT University

St. Teresa Church

Saras Baug

VishramBaug Wada

Hadapsar Airport

Chatushrungi Temple

Kelkar Museum

Agakhan Palace

SP College

Janglimaharaj Temple

Peshwe Park

Shinde Chhatri

Dr. Ambedkar College

St. Merys Church

Rajiv Gandhi Zoo Park

Parvati Hill

Agriculture College

Ohel David Church

Empress Garden

Pataleshwar Caves

Deccan College

Katraj Jain Temple

Bund Garden

Tribal Research

Savitribai Phule Pune

Kasba Ganpati

Race Course

Center University

National War Sinhagad Institute Deccan Gymkhana
Memorial Wadgaon Ground
Balgandharv TMV Pune Mula-Mutha Bird

Rangmandir

sanctuary

Mahatma Phule
Wada

Dr. Babasaheb
Ambedkar Sanskritik
Bhavan

Chhatrapati Sambhaji
Park

PMC Building

Furgusson college

Bharati Vidyapeeth

Yerawada Prison

Osho International

MIT college




Il. Creating database for these places using Geospatial technology.

Since we have already categorized the tourist places, now we will move on with actually plotting
it on Google Earth. We will follow the same procedure as explained in IGET_MP_001.

1. We will search for individual places on Google Earth and mark it using placemark tool
and name it accordingly and save it in one folder.

> - o

File Edit View Tools Add Help

¥ Search (=]

e — —
Sharivar Wada Fort, (Search 39 .

ex: 3725 19.1N, 12 W
Get Directions History [

A Shaniwar Wada Fort Namellshamwarwada l
Shanivar Petn, Fune, Maharashra
3505612 6567
maharashtrate jov.in Latitude: | 18°31'9.30°N
Fookoel 177
Longitude: | 73°51'19.56'E

Description | style, Color | view | Altitude |

] Addlink... | Addimage...

v Places
5 M@ My Places
& MIED Sightseeing Tour
Make sure 30 Buildings
layer s checked

(R
haniwardWe da For
R

O Temporary Places

Q \ 1] PR
¥ Layers Earth Gallery >
= M2 Primary Database
® O Voyager
# O Borders and Labels
O places
# 02 Photos
D= Roads '
# ME) 30 Buildings (] ,
# B Ocean Tour Guide A 2 2002 |

2. Save the file as ‘.kml’ file

File Edit View Tools Add Help
¥ Search

[Shaniwar Wada Fort, Shaniwar P | Search
ex: 3725 19,1, 12205 06'W

Get Directions History |8

€« v <« Documents > New folder v Search New folder »p

A\ Shaniwar Wada Fort

Sheniwar Peth, Pune, Mahsrashtra

Organize v New folder Bz v

020 2612 6367
maharashratourism. govin
ok 177 reviews

® 9

~

Date modified Type

No items match your search

B X
v Places
= M My Places

# MIE Sightseeing Tour
Make sure 3D Buildings

layer is checked
' Shaniwar wada
OE Temporary Places

Add

Cut
Copy

Q@ [a]w D
v Layers Earth ez
= M2 primary Database

@ OQ Voyager Po:

# OF Borders and Labels —

O3 places el

@ 0= photos Directions from here
Directions to here

Snapshot View

Properties

3. Repeat this process for all the listed tourist places.
4. Also mark the Main bus stops and railway station (Swarget bus stand, Pune railway
station)



Iv.

Adding attributes to the collected data

We will find out the shortest route and the distance from each tourist place to the main bus
stand and the railway station. There are two ways of calculating distances between the two
points. One is Euclidean distance (As the crow flies) and second the actual distance. To
calculate Euclidean distance we only need two points and the ‘Distance matrix’ will
calculate the distances between the two points. For calculating actual distances on ground we
will need the road layer, which will give exact route from one point to another.

In this tutorial we will consider both the cases.

Ul

7.

8.

A. Calculating Euclidean Distances between the points.

Before we actually proceed with the shortest path we will convert the tourist’s places
which we have saved as ‘.kml’ to ‘.shp’ so that the calculations are easier.

Open the ‘.kml’ file = right click and ‘Save As’ and select it as ‘Esri shapefile’ 2 click
‘OK’ once you have saved all your files in appropriate folders, open all the shapefiles and
remove all kml layers in QGIS map window.

Project all the layers in projected coordinate system, in this case we will convert the
shapefiles into UTM 43N. (Please refer IGET_GIS_002 for projecting the layers).

(If you want skip first three sections and directly want to continue from here then use the
data provided with this tutorial ‘Tourist_Places’)

Goto Menu > Vector > Analysis tools > Distance matrix.

A new window will open up. Firstly we will find out distances from Pune station to evry
tourist place. So give the ‘Input point layer’ as ‘Pune_Station’ and keep ‘Input
unique ID field’ as ‘Name’

/ Distance matrix ? X

Input point layer

Pune_station v @
Input unique ID field
IName v

Target point layer
Tourist places v @

[Target unique ID field

[ Name v

Output matrix type
® Linear (N*k x 3) distance matrix
Standard (N x T) distance matrix
Summary distance matrix (mean, std. dev., min, max)

Use only the nearest (k) target points 1

4

Output distance matrix @
[Dist_rail_stn.csv | Browse I
0% | € ox ) Close

Next select the ‘Target point layer’ as ‘Tourist places’ and ‘Target unique ID
field’ as ‘Name’
Let the output matrix type be default as linear distance matrix.
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9. Save the ‘Output distance matrix’ in appropriate folder in your local disk using
‘Browse’

10. Click ‘OK’ and the the distance matrix file will be saved as .csv file.

11.Now we will load this file in map canvas and then join it with the attribute of tourist
places. To load the file navigate to Menu > Layer > Add Layer > Add delimited
text layer.

12.The new window will open up. Browse through your folders and select the previously
saved .csv file.

13. Next Select ‘No geometry (attribute only table)’ from Geometry definition. And click
loKl

/ Create a Layer from a Delimited Text File ? 11
File Name 3/Dist_rail_stn.csv
Layer name | Dist_rail_stn Encoding | UTF-8 v
File format ® CSV (comma separated values) Custom delimiters Regular expression delimiter
Record options Number of header lines to discard | 0 < | 1% First record has field names
Field options Trim fields Discard empty fields Decimal separator is comma Cl' 2
Geometry definition Point coordinates Well known text (WKT) [O No geometry (attribute only table)]
Layer settings [] Use spatial index Use subset index Watch file
InputiD TargetiD Distance (2]
1 |Railway_Sta |Dr_babasaheb_Ambedkar_Sans_Bha |820.756245139 L‘
2 |Railway_Sta | Ohel_David_Church 1051.02498821
3 |Railway_Sta | Tribal_Research_Center 1204.94038849
4 |Railway_Sta | Osho_International 167700817978
| 5 |Railway_Sta | Dr_Ambedkar_Coll 1688.46240228 [T
= P
|6 Railway_Sta | Bund_Garden 1701.59900532
' Cancel Help

14.Table is now added to table of content list. Now we will join this table with Tourist places
shapefile using ‘Name’ as an unique ID.

15. Goto properties of Tourist places > Join = Give Unique Id > click OK. (Refer the screen
shot for further reference).

\7‘ |

] Join layer Join fiekd Target field Memory cache

7 Add vector join ? X
N style + J
€3 Labels Join layer | Dist_rail_stn -
Join field | TargetiD |~

B8 Fields

Target field |Name |~
9 oy X Cache join layer in virtual memory
U@ Actions [ Create attribute index on join field

m > Choose which fields are joined

» || Custom field name prefix
IER oigrams

@ vewata

e

—~
@
syie - Cancel Apply Hebp

16. Open the attribute table of Tourist places layer and check if all the attributes are added
to the table.

[
@_t' 7
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17. Repeat the same procedure for calculating distance between swarget Bus_stand and the
Tourist places.

18. Once both the distances are calculated, the attribute table of Tourist places should be as
shown in the screen shot below.

/ Attribute table - Tourist places :: Features total: 47, filtered: 47, selected: 0 — O X

/BlB|e @28 PoREE :
Name Descriptio iist_rail_stn_Inputll | ist_rail_stn_Distanc | st_bus_stnd_Input] |it_bus_stnd_Distan | |*

o0 |PashanLake Railway_Sta 9431.78937121 | Swarget_ST 8688.53811109

1 |Dadusheth_Ganp... Railway_Sta 2379.0606598 | Swarget_ST 1902.10371154

2 |Shaniwar_Wada Railway_Sta 2269.50657394 | Swarget_ST 2242,72185618

3 |Saras_Baug Railway_Sta 3812.78382304 | Swarget_ST 678.163833517

4 |Lal_Mahal Railway_Sta 2213.74707052 | Swarget_ST 2150.58456684

5 |Peshwe_park Railway_Sta 3926.08422737 | Swarget_ST 822.249926492

6 |Kelkar_Museum Railway_Sta 2900.56581696 | Swarget_ST 1346.52360513 f

7 |VishramBaug_Wa... |/ Railway_Sta 2775.99923856 | Swarget_ST 1697.03623223

8 |Empress_Garden Railway_Sta 3110.56740872 | Swarget_ST 4397.83186354

g |Agakhan_Palace Railway_Sta 3896.50145715 Swarget_ST 7397.02364997

10 |Bharti_Uni Railway_Sta 7900.38419823 | Swarget_ST 4441.72668469

11 |SPPune_Uni Railway_Sta 5844.33476314 | Swarget_ST 6849.17227765

12 |Furgusson_coll Railway_Sta 3619.59816168 Swarget_ST 3223.67867539

13 |MIT_coll Railway_Sta 6076.21421127 | Swarget_ST 4378.58149926

14 |Sinhagad_Ins_W... Railway_Sta 8025.74239651 | Swarget_ST 4412.0872613

15 |TMV_Pune Railway_Sta 4075.17992274 | Swarget_ST 942,200928893

16 |Parwati_Hil Railway_Sta 4599.30665929 | Swarget_ST 1351.94307788

17 |Shinde_Chhatri Railway_Sta 4766.19834973 | Swarget_ST 4115.20678994 @

1n lRaiiv_Gandhi_7n AEL Railwav_Sta R435 R7R1710A_ Swarnet ST SN71 ARN1N273

19. The join which we have performed on the layer is virtual join, so we will save this layer as
shapefile to keep all the joint records.

20. We can delete the attribute which are not required. So keep only the field ‘Name’
‘Dist_rail_1" and ‘Dist_bus_1". Attribute table will look as follows:

,/,; Attribute table - Tourist_places_Wd_dist :: Features total: 47, filtered: 47, selected: 0 - [m] X
/B¢ aE2eS PO EEE ’
Name Dist_rai_1 Dist_bus_1
0 |Pashanlake 9431.789371210...| 8688.53811109
1 |Dadusheth_Ganp... | 2379.060659799... | 1902.10371154
2 |Shaniwar_Wada 2269.506573940... | 2242.72185618
3 |Saras_Baug 3812.783823039... | 678.163833517
4 |Lal_Mahal 2213.747070519... | 2150. 58456684
5 |Peshwe_park 3926.084227370... | 822.249926492
6_ Kelkar_Museum 2900.565816960... | 1346.52360513
7 |VishramBaug_Wa... | 2775.999238559... | 1697.03623223
g |Empress_Garden | 3110.567408720...|4397.83186354
g |Agakhan_Palace 3896.501457150... | 7397.02364997
10 |Bharti_Uni 7900.384198230... | 4441.72668469
11 |SPPune_Uni 5844.334763140... | 6849.17227765
? Furgusson_coll 3619.598161679... | 3223.67867539
13 |MIT_coll 6076.214211270... | 4378.58149926
14 |Sinhagad_Ins_W... | 8025.742396509... | 4412.0872613
15 |[TMV_Pune 4075.179922740... | 942.200928893
16 | Parwati_Hill 4599.306659290... | 1351.94307788
17 | Shinde_Chhatri 4766.198349729... | 4115.20678994 @
I~ |Raiv_Gandhi 7n | R435 R7R171N5Q_| G071 ARN1NDT7R

&4 show All Features |

21.Now we have got distance between individual tourist places and the major public
transport places. The distances calculated are in meters as the layer was in projected
coordinate system.

@—tt 8
d
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B. Calculating Actual distances between the points

22.To find out shortest path between certain points we need road layer. And best possible

road network available for use is ‘Open Street Map’. We can download this network using
QGIS.

23. Open the Pune PMC boundary in QGIS map interface from the given data set.
24. Goto Plugins and install ‘OpenStreetMap’ plugin using search tool.

Note: To download any plugin from QGIS respesotery you will need internet connection. For more on how
to connect your QGIS to internet and how to install plugins please refer ‘IGET_GIS_ 001’

25. 0Once you install this plugin, it will be listed under ‘Vector’ tab of Menu bar.
26. Navigate to ‘Vector’ - ‘OpenStreetMap’ 2> ‘Download Data...’

4 QGIS 2.8.2-Wien

Project Edit View Layer Settings Plugins Q@ Raster Database Web MMQGIS Processing Help

. Coordinate Capture &

D ‘J ﬂ ’{7

‘ ) °° @ o
( 7_:) M\ any - o
a » Spatial Query Export Topology to SpatiaLite...
Browser Topology Checker b
) - Analysis Tools »
Vo | T @ 4 socly
32 Research Tools 4
&
'0 ® Home 4 Geoprocessing Tools 4
Favourites

' c:f ', Geometry Tools 4
U E:/ a Data Management Tools  »

27.The new window will open up. Select Extent ‘From Layer’ and select ‘PMC_Boundary’
as the layer.

28. Save the output in appropriate folder with appropriate layer name and click ‘OK’
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/ Download OpenStreetMap data ? X

Extent

From map canvas
@rom layer IPMC_Boundary v 'l

Manual
18.6223
73.7492 73.9636
18.4275
Output file

/Pune_OSM_Road.osm m

29. Depending on the internet speed it will take 5-10min for the download. Wait till the time

layer is downloaded.

30. Save the downloaded .osm layer as shapefile (Only save polyline file and can exclude

other downloaded files)

31. Demarcate the Public transport places with different symbol for better and easy

understanding. Also label the feature for easier identification.

4 QGIS 2.82-Wien
Project Edit View Layer Settings Plugins Vector Raster Database Web MMQGIS Processing Help

NEBROR S0BPLPAPPLRALKR a-HN-peEE=
.’/, / [—/} oo (% P{ ﬁ =g 3 (abe| ﬂj =3 = nbi] ab{] abg ‘isw "> 9
N e RVIRRAREOR R ® L O g A Us |5 04 0% 0% A [ bp
Browser @)
V:eova
He
e i
:
. 2//
f P mssqL @
[ Wate N
R Layers @)X
@ ® TE@@E 2
* £3_ _Pune station
q x Swarget_Bus_stop
% ® Tourist_places_Wd_dist
@ X — 0SM_Layer_PMC
% [ ] PMC_Boundary
5, - &%
@ Start
9,
Stop
\/:v
[bfy | criterion Length =
| Length
= Time
(Rm Calculate Export Clear
¥ Sinep
Toggles the editing state of the current layer Coordinate: 74.0231,18.5306 Scale | 1:120,698 v Rotation: 0.0

-

2 XRender @eErsc:as(0F) @

10
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32. Now we will move on with finding the shortest distance from each point to railway station
and the Swarget bus stand. Make sure that the ‘Road graph plugin’ is installed in your
QGIS version. If not then install it from plugin manager.

33. The interface of installed plugin will look like the image below.

Shortest path =)E3

Start

Stop

Criterion Length v
Length

Time

Calculate Export Clear
: g Help

34.So this tool can be used to find the shortest path between the two required points. We
will see how we can calculate this path and even export this route for further reference.

Note: We have to have the shapefiles in projected coordinate systems for calculating distances.

35. Before we actually calculate the routes we will do Road graph plugin setting and then
proceed with route calculation.

36. Navigate to Menu > Vector > Road Graph > Settings

37.Set the ‘Time unit’ as ‘hour’ and ‘Distance unit’ as ‘Kilometer’. We can change
these units as per our convenience and requirements.

38.In ‘Transportation layer’ tab select ‘layer’ as ‘OSM_Layer_Pune’

/ Road graph plugin settings ? X
Time unit hour >
Distance unit kilometer v
Topology tolerance 0.00000 :

Transportation layer Default settings
Direction field Always use default ¥
Value for forward direction

Value for reverse direction

Value two-way direction

Speed field Always use default v kmh ~

Co ) o ||

39. Click ‘OK’" and your plugin is ready to be used for calculating distances and routes.
40. Now we will find out distance between individual tourist place and the public transport
station.

[
@‘t 11
4
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41. In shortest path window click on button next to Start option

42.Zoom in to navigate to the Swarget bus stand point on the map canvas and click on that
point. So that the Shortest Path tool considerers Swarget as the start point.

43. Now similarly we will select end point. Firstly we will consider the closest place eg.
Parwati_Hill.

44, Click on ‘Calculate’ and visualize the shortest path in the map canvas.

%‘t? 12
4
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0 =@ E G

% Y Pune_station
% ¥ swarget_Bus_stop
X ® Tourist_places_Wd_dist

% —— 0SM lLayer Pune
% [] PMC_Boundary

Start
| (379570,2.045832 +06)
Stop

| (378251,2.045542 +06)

45. We can also export this route for future analysis, if required.
46. Click on ‘Export’ and save this route as ‘New temporary layer’

.............................. Stursest path s (@50
Start

| (379570,2.04583¢ +06) J

Stop lew temporary layer )|
| (378251,2.04554¢ +06) J

Criterion Length Iz

Length | 1.6226%m

Time [1.62%41

& Hep

47.You can save this layer as shapefile if required.

48. Similarly compute the shortest routes from swarget to all the tourist places and from
Pune_station to all the tourist places. Export it and save it as shapefie.

49. Prepare a map showing all the Tourist places and corresponding shortest possible paths
connecting them to major public transport stations in Pune.

Task:

1. Create a map of all the tourist places within 5km area around Swarget and Pune station.
2. Generate the shortest path between Rajiv_Gandhi_Zoo_Park and Agakhan_Palace.

Zet &
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